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1 Introduction

1.1 What is the INFO-CON Download Adapter Software?
The Model 9972 INFO-CON Download Adapter Software is used with the
Model 2372 INFO-CON Download Adapter to program an INFO-CON connec-
tor with new probe calibration coefficients without using the Model 1521 LLK
Handheld Thermometer readout or Model 1522 LLL Handheld Thermometer
readout.

The Model 2372 INFO-CON Download Adapter is a small metal box that has a
9-pin serial cable. The serial cable connects to a serial (COM) port on a PC.
The software can then be used to read, edit, and write changes to the
INFO-CON connector.

Each probe that is used with the Model 1521 LLK or Model 1522 LLL
thermometer readout is attached to an INFO-CON connector. The connector is
programmed with the calibration information specific to that probe. When a
probe is attached to the thermometer, the thermometer automatically reads the
calibration information from the connector, thus eliminating the need for the
technician to manually enter the calibration information into the thermometer.

This software allows the serial number, calibration date, expiration date, con-
version type, probe wires, and conversion coefficients to be read in, viewed, ed-
ited and written back out to the connector. This software also allows the
information to be saved to a file on disk.

1.2 Features
The INFO-CON Download Adapter Software provides a fast, convenient way
to program the Hart Scientific INFO-CON connector.

The INFO-CON connector was designed by Hart Scientific for use with the
Model 1521 LLK and Model 1522 LLL Thermometer readouts. The connector
is used to store information about the probe that is attached to it. This informa-
tion includes:

• Probe Serial Number

• Probe Calibration Date

• Probe Calibration Expiration Date

• Conversion Type

• Probe Wires

• Conversion Coefficients

9972 INFO-CON 1
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This software provides an easy-to-use Windows® interface for setting this infor-
mation. This software also provides some other features for handling this infor-
mation including:

• Formatting/Erasing connectors

• Saving information to binary file

• Reading information from binary file

• Saving all information to text file

• Saving coefficients to text file

• Reading coefficients from text file

1.3 Requirements
The following minimum hardware and software requirements are expected to
run the INFO-CON Download Adapter Software.

1.3.1 Computer Hardware Requirements
The following minimum computer configuration is required to run the software:

• IBM compatible 486 PC or better with 8MB RAM (Pentium class proces-
sor with 16MB RAM or more recommended)

• VGA monitor or better

• CD-ROM drive for installation

• 1- RS-232 serial communication port (COM port)

• Minimum 7 MB Hard Disk space

1.3.2 Computer Software Requirements
This software requires the following operating system:

• Windows® 95/98/ME or

• Windows® NT/2000/XP

1.3.3 Other Requirements
This software also requires the following:

• 1- Model 2372 INFO-CON Download Adapter (included)

• INFO-CON connector(s)

2 Hart Scientific
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1.4 Software Installation
A backup should always be made of your hard disk drive before installing any
software and all running applications should be closed.

Note: If this software has been previously installed on this computer, follow the
Uninstalling the Software instructions below before proceeding!

1.4.1 Installing from CD
1. Insert the INFO-CON Download Adapter Software CD-ROM into your

CD-ROM drive. The Setup program should run automatically.

2. Follow the on-screen instructions. The README file will be displayed.
Read this file for important information that was not available when the
manual was printed.

3. The software files are copied to the specified folder.

4. The installation creates a menu option in the Programs menu called
Hart Scientific 9972. The program, help file and README icons are
all located in this menu.

1.5 Uninstalling the Software
The INFO-CON Download Adapter Software installation creates an entry for
uninstallation in the Add/Remove Programs option in the Control Panel. To
uninstall the software, follow the instructions below:

1. Open the Control Panel by selecting the Settings | Control Panel option in the
Start menu.

2. In the Control Panel, double-click the Add/Remove Programs icon to open
the Add/Remove Programs dialog.

3. In the list that appears, locate and click on the 9972 INFO-CON entry.

4. Click the Add/Remove (Windows® 9x/ME/NT) or Change/Remove (Win-
dows® 2000/XP) button.

5. Follow the on-screen instructions to remove the software.

Note: Removing this software does NOT delete any files that have been
saved since the software was installed. These files must be deleted manually
using Windows® Explorer.

Note: When removing the software, you may receive one or more prompts
to choose whether or not to delete a specific file from the system as the soft-
ware is being removed. Be careful not to remove a file that is required by an-
other application. To be safe, you may wish to choose NOT to remove one or
all of these files. If you are sure the files are not used by any other applica-
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tions, they may be removed. For a list of files that this software installs on your
system, see Section 1.7, Required .DLL and .OCX Files.

6. When finished removing the software, close the Add/Remove Programs dia-
log by clicking the OK (Windows® 9x/ME/NT) or Close (Windows®
2000/XP) button.

1.6 Running the Software
To run the Model 9972 INFO-CON Download Adapter Software, click the Start
button, then select Programs | Hart Scientific 9972 and click on the 9972
INFO-CON Software icon.

Every time this software is run, it checks to make sure that all of the required
.DLL and .OCX files are found on your computer. If the software detects that
an older file has replaced one or more of these files or that the file is not found,
the Shared Files Conflict dialog (Figure 1) appears detailing the problems
found.

Every time you install any software on your computer, it is a good idea to make
a backup of your important files, including all files in the \WINDOWS (or
\WINNT) and \WINDOWS\SYSTEM (or \WINNT\System32) folders. Some-
times during the installation process, a file may be replaced with an older ver-
sion that is not 100% compatible with the first. This may cause the software to
perform unexpectedly or fail to run at all. Replacing a .DLL or .OCX file with a
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newer version does not usually cause any problems because these files are typi-
cally backward-compatible. There are, however, exceptions to this rule.

If the Shared Files Conflict dialog is displayed when you run the software, a list
of the files is shown in the Incompatible Files list. Select each of the files, one
at a time, and read the information that appears in the bottom half of the dialog.
Depending on the information given, you must decide what to do. The software
may continue to run without problems, however there is no guarantee of this. If
some files are missing, the best option is usually to uninstall and reinstall the
software.

The .DLL and .OCX files are typically located in the \WINDOWS\SYSTEM
(or \WinNT\System32) folder. If you find it necessary to avoid conflicts, these
files can be copied to the folder where the software was installed. Be sure to
compare the files on your computer with the list of required .DLL and .OCX
files (see Section 1.7).
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After selecting the Continue button or if there were no file conflicts, the
INFO-CON Download Adapter Software Main Display is shown.

1.7 Required .DLL and .OCX Files
This software requires certain .DLL and .OCX files to function properly. All re-
quired files are shipped on the installation CD-ROM. A list of these files and
their required date stamp follows:

.DLL Files Date

HARTCOMM.DLL‡ 04/13/1999

HARTCONV.DLL‡ 06/21/1999

IB97E32.DLL‡ 04/01/1998

IBFS32.DLL‡ 04/01/1998

MFC40.DLL† 04/24/1998

MFC42.DLL† 09/26/1998

MSSTDFMT.DLL† 06/18/1998

MSVBVM60.DLL† 09/25/1998

MSVCRT.DLL† 01/05/1999

MSVCRT40.DLL† 05/31/1998

SCRRUN.DLL† 05/26/1998

.OCX Files Date

COMDLG32.OCX† 06/24/1998

DWVSTP32.OCX† 03/26/1999

MSCOMCT2.OCX† 05/07/1999

MSCOMCTL.OCX† 06/26/1998

SSCALA32.OCX† 01/12/1999
† These files are very likely to be used by other applications. When
uninstalling this software, you may wish to choose not to remove these
files from your system if prompted.

‡ These files are specific to this software and are very unlikely to be used
by other applications. When uninstalling this software, you should choose
to remove these files from your system if prompted.
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1.8 Quick Start
The following information is intended to provide a brief overview on how to
get the INFO-CON Download Adapter Software up and running quickly.

1. Click the Start button and select Programs | Hart Scientific 9972 | 9972
INFO-CON Software.

2. Connect the Model 2372 INFO-CON Download Adapter to one of the
COM ports on the computer.

3. Insert an INFO-CON connector into the adapter. The probe information
is read in automatically.

4. To change the information, use the options under the Edit menu. The
software prompts to confirm writing changes out to the INFO-CON
connector.

5. Remove the INFO-CON connector when finished.

6. Repeat steps 3 - 5 for other INFO-CON connectors.
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1.9 INFO-CON Download Adapter Software Main Display
The INFO-CON Download Adapter Software expects to communicate with an
INFO-CON connector through the Model 2372 INFO-CON Download Adapter.
This adapter must be connected to a serial (COM) port on the computer. When
running this softwre for the first time, the software displays a prompt to select
the appropriate COM port. Connect the adapter to a COM port at this time and
select the appropriate COM port from the dialog displayed.

When the software detects the presence of the Model 2372 INFO-CON Down-
load Adapter, a prompt is displayed stating that an INFO-CON connector may
be plugged into the adapter at any time. The software constantly monitors the
adapter to determine when an INFO-CON connector has been plugged in.

When the software detects an INFO-CON connector, it automatically attempts
to read the probe information from the connector and displays it on the screen.
The settings can then be modified using the Edit menu options.

If any of the connector information has been changed but not written back to
the INFO-CON connector, the text color for that information changes to red.
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When the information is written to the INFO-CON connector using the Con-
nector menu, the text color changes back to black.

1.10 Toolbar

The toolbar (Figure 3) provides quick access to many of the most common
functions of the software.

The following buttons are available on the toolbar.

New - Erases current probe and coefficient information from the
connector

Open - Opens a previously saved file containing probe and coefficient
information

Save As - Saves the current probe and coefficient information to a file

Edit Serial Number and Dates - Allows the serial number and calibra-
tion dates information to be changed

Edit Coefficients - Allows the conversion type and coefficients to be
changed

Read Connector - Reads in the probe information from the INFO-CON
connector

Write Connector - Writes changes that have been made to the
INFO-CON connector

Help - Opens the Model 9972 INFO-CON Download Adapter Software
Help File
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2 File Menu

The File menu (Figure 4) provides options for creating a new configuration,
opening an existing INFO-CON file, saving an INFO-CON file, setting up pro-
gram defaults and exiting the program.

2.1 New

The New option erases the settings in the INFO-CON connector so that the set-
tings for a new probe can be entered. The software always prompts for confir-
mation before erasing the current settings.

Once a connector has been erased, it no longer contains any information about
a probe.

This feature is useful when a probe must be disconnected from an INFO-CON
connector so that a new probe can be connected to it. Erasing the current set-
tings ensures that the INFO-CON connector will not contain any incorrect in-
formation about the probe that is connected to it.

Selecting New from the File menu performs the same function as selecting For-
mat from the Connector menu.

2.2 Open

The Open menu option allows a previously saved INFO-CON file (.ICF) con-
taining probe and coefficient information to be opened and written to the
INFO-CON connector.
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This feature is useful for restoring probe information to an INFO-CON connec-
tor in case the connector gets erased or damaged and must be replaced.

Selecting the Open menu option displays the Open INFO-CON File dialog. Se-
lect the .ICF file that contains the probe information that should be written to
the INFO-CON connector. Then click the Open button to open the file. The cur-
rent settings of the INFO-CON connector will be overwritten with the informa-
tion in the .ICF file.

Note: The Open menu option will open only .ICF files written by this software.
Attempting to open any other type of file may cause unpredictable results.

2.3 Save As

The Save As menu option allows the current INFO-CON connector settings to
be saved to an INFO-CON file (.ICF). These files are binary files and cannot be
read by a text editor.

This feature is useful for keeping a copy of the information stored on the
INFO-CON connector in a file on the computer in case the connector gets
erased or damaged and must be replaced.

Selecting the Save As menu option displays the Save INFO-CON File dialog.
Enter a descriptive, unique filename that identifies the probe information being
saved in the file (i.e. possibly include the probe model and/or serial number in
the filename). These filenames can be up to 256 characters in length. The file
MUST have a .ICF extension, however. This software will not allow files with-
out a .ICF extension to be opened using the Open menu option.

2.4 Save As Text
The Save As Text menu option allows the current INFO-CON connector set-
tings to be saved to a text file which can then be opened by any text editor and
printed. The probe information is arranged in a report-style format (Figure 5).

This feature is useful for keeping a hardcopy (printout) of the information
stored on the INFO-CON connector.

Selecting the Save As Text menu option displays the Save INFO-CON Text File
dialog. Enter a descriptive, unique filename that identifies the probe informa-
tion being saved in the file (i.e. possibly include the probe model and/or serial
number in the filename). These filenames can be up to 256 characters in length.
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After the file has been saved, it can be opened and printed from any text editor
such as Notepad or WordPad (which are both shipped with Windows®).

This software cannot open or read these text files. However, this software can
read text files that contain only coefficients. For more information, see the Co-
efficients - Open menu option in Section 3.2.4.
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2.5 Defaults
The Defaults dialog (Figure 6) is displayed when the Defaults option in the File
menu is selected.

2.5.1 Communications
The Communications tab allows the user to select the COM port to communi-
cate between the computer and the Model 2372 INFO-CON Download
Adapter.

Select the serial (COM) port to which the Model 2372 INFO-CON Download
Adapter is connected by clicking the down arrow on the drop-down list. All of
the COM ports on the computer should appear in the drop-down list. Each
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COM port is accompanied by a symbol that reflects the current state of the
COM port as follows.

COM ports with this symbol are available on this computer and can be
selected.

The COM port with this symbol is currently being used by this soft-
ware.

COM ports with this symbol are in use by another application and can-
not be used by this software at this time.

Choose the COM port that the Model 2372 INFO-CON Download Adapter is
connected to and select the OK button to accept the change and close the dia-
log. Selecting the Cancel button discards any changes made and closes the
dialog.
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2.5.2 Other Settings
The Other Settings tab allows the user to select whether or not current settings
are overwritten.

The Overwrite prompts option allows the user to choose how the software
should handle writing changes back out to the INFO-CON connector. Select
one of the following options.

• Always prompt before overwriting current settings

• Never prompt before overwriting current settings

Selecting the Always prompt before overwriting current settings option forces
the software to display a prompt to confirm writing changes out to the
INFO-CON connector. This option is selected by default.

Selecting the Never prompt before overwriting current settings option sup-
presses the confirmation prompts. Changes are automatically written out to the
INFO-CON connector.

2.6 Exit
Select the Exit option from the File menu to close the software.

If any changes have been made to the current INFO-CON connector settings,
the software displays a prompt to write the settings to the connector before
exiting.
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3 Edit Menu

The Edit menu (Figure 9) provides options for entering and modifying the in-
formation stored in the INFO-CON connector.

3.1 Serial Number and Dates
The Serial Number and Dates dialog allows the user to enter and/or modify the
serial number, calibration date and expiration date information that is stored in
the INFO-CON connector.

After the necessary changes have been made, select the OK button to write the
new settings out to the INFO-CON connector. Depending on the setting of the
Overwrite prompts option on the Defaults dialog, see Section 2.5.2, a prompt
may be displayed asking for confirmation to write the new settings to the
INFO-CON connector.

Select the Cancel button to discard any changes made and to return to the main
display.

Select the Help button to display the appropriate help topic for this dialog.
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3.1.1 Serial Number
Enter the serial number of the probe attached to the INFO-CON connector. The
serial number can be up to 10 characters long and can contain any combination
of numbers (0–9), letters (A–Z), dashes (-), slashes(/), and periods (.).

3.1.2 Calibration Date
Select or enter the date that the probe attached to the INFO-CON connector was
last calibrated. The range of allowable dates is from 01/01/1970 to 12/31/2100.

3.1.3 Expiration Date
Select or enter the date that the calibration of the probe attached to the
INFO-CON expires or is due for another calibration. The range of allowable
dates is from 01/01/1970 to 12/31/2100.

Note: The 1521 and 1522 Thermometer readouts will display a message indi-
cating that the probe calibration has expired if this date is prior to the current
date in the 1521 or 1522 thermometer readout.
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3.2 Coefficients
The Coefficients dialog allows the user to enter and/or modify the conversion
type and coefficient information that is stored in the INFO-CON connector.

After the necessary changes have been made, select the OK button to write the
new settings out to the INFO-CON connector. Depending on the setting of the
Overwrite prompts option on the Defaults dialog, see Section 2.5.2, a prompt
may be displayed asking for confirmation to write the new settings to the
INFO-CON connector.

Select the Cancel button to discard any changes made and to return to the main
display.

Select the Help button to display the appropriate help topic for this dialog.

3.2.1 Conversion Type
Select the conversion type for the attached probe based on the information on
the Report of Calibration for that probe. The allowable choices are:
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• Callendar-Van Dusen

• IEC-751

• ITS-90

• Thermistor

• YSI-400

3.2.2 Wires
Select the wires settings that matches how the attached probe is connected to
the INFO-CON connector.

3.2.3 Coefficients
The coefficients that must be entered change depending on the selected conver-
sion type. Enter the coefficients for the probe that is attached to the INFO-CON
connector. The coefficients can be found on the Report of Calibration for the
probe.

Note: All coefficients are automatically rounded off to the maximum number of
digits that the 1521 or 1522 thermometer readout will allow.

A description of each of the different sets of coefficients is given below.

3.2.3.1 ITS-90

When the conversion type is set to ITS-90, the following coefficients must be
entered:

• RTPW - Enter the value for the Resistance at the Triple Point of Water
from the Report of Calibration.

• High Range Coefficients A, B, C, and D - Enter the High Range coeffi-
cients (range 6 - 11) from the Report of Calibration into the appropriate
boxes. High range coefficients are denoted by the coefficient letter fol-
lowed by a number indicating the temperature range over which the probe
was calibrated (i.e. A9, B8 or C7).

• Low Range Coefficients A and B - Enter the Low Range coefficients
(range 4 - 5) from the Report of Calibration into the appropriate boxes.
Low range coefficients are denoted by the coefficient letter followed by a
number indicating the temperature range over which the probe was cali-
brated (i.e. A4 or B5).
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3.2.3.2 Callendar-Van Dusen

When the conversion type is set to Callendar-Van Dusen, the following coeffi-
cients must be entered:

• R0 - Enter the Resistance at 0°C from the Report of Calibration.

• ALPHA - Enter the ALPHA coefficient from the Report of Calibration.

• DELTA - Enter the DELTA coefficient from the Report of Calibration.

• BETA - Enter the BETA coefficient from the Report of Calibration. If
there is no BETA coefficient on the Report of Calibration, enter 0.0.

3.2.3.3 IEC-751

When the conversion type is set to IEC-751, the values for R0, ALPHA,
DELTA and BETA are fixed and cannot be changed by the user. The following
describes the default values for each of these coefficients:

• R0 - 100.000

• ALPHA - 0.00385

• DELTA - 1.507

• BETA - 0.111

Note: The Open and Save As buttons are disabled when IEC-751 is selected as
the Conversion Type.

3.2.3.4 Thermistor

When the conversion type is set to Thermistor, the following coefficients must
be entered:

• b0 - Enter the b0 coefficient from the Report of Calibration.

• b1 - Enter the b1 coefficient from the Report of Calibration.

• b2 - Enter the b2 coefficient from the Report of Calibration.

• b3 - Enter the b3 coefficient from the Report of Calibration.

Note: If the Report of calibration does not list any one of these coefficients, set
that coefficient to 0.0 (i.e. the Steinhart-Hart method requires the b2 coefficient
to be set to 0.0). These are the T(R) coefficients for the probe and are some-
times also referred to as a, b, c, and d.
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3.2.3.5 YSI-400

When the conversion type is set to YSI-400, the values for b0, b1, b2 and b3 are
fixed and cannot be changed by the user. The following describes the default
values for each of these coefficients.

• b0 - –6.63329214e00

• b1 - 4.57873226e03

• b2 - –6.49255492e04

• b3 - –7.27819196e06

Note: The Open and Save As buttons are disabled when YSI-400 is selected as
the Conversion Type.

3.2.4 Open
The Open button allows a previously saved coefficients text file to be opened.
Coefficients text files can be saved by selecting the Save As button. Before
opening a coefficients text file, set the Conversion Type option to the type of
coefficients that are stored in the file. See Coefficients Text Files in Section
3.2.6 for more information on the uses and format of these files.

Selecting the Open button displays the Open Conversion Type File dialog. Se-
lect the file that contains the probe coefficients that should be written to the
INFO-CON connector.

Note: Opening a file with an extension other that that shown in the Files of
Type box may cause unpredictable results. Then click the Open button to open
the file.

3.2.5 Save As
The Save As button allows the current coefficients to be saved to a text file. Co-
efficients text files can be opened by selecting the Open button. See Coeffi-
cients Text Files in Section 3.2.6 for more information on the uses and format
of these files.

Selecting the Save As button displays the Save Conversion Type File As dialog.
Enter a descriptive, unique filename that identifies the probe information being
saved in the file (i.e. possibly include the probe model and/or serial number in
the filename). These filenames can be up to 256 characters in length. The file
extension must reflect the type of coefficients stored in the file if the file is to
be opened by this software.
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3.2.6 Coefficients Text Files
Coefficients Text Files provide a way for probe coefficients to be saved to a
disk file independent of other information about the probe. These files can also
be opened, edited and printed using any text editor such as Notepad or
WordPad (which are both shipped with Windows®).

When saving Coefficients Text Files, use the extension that appears in the Files
of Type box. The default extension depends on the currently selected conver-
sion type as described below. The format of each of the file types is explained
in Sections 3.2.6.1, 3.2.6.2, and 3.2.6.3.

Conversion Type File Extension

Callendar-Van Dusen .CVD

ITS-90 .I90

Thermistor .THR

Note: The Open and Save As buttons are disabled when either IEC-751 or
YSI-400 is selected as the Conversion Type.

3.2.6.1 CVD Files

The following is an example of the format of the .CVD file.

• The first line of a .CVD file is the value of the R0 coefficient.

• The second line of a .CVD file is the value of the ALPHA coefficient.

• The third line of a .CVD file is the value of the DELTA coefficient.

• The fourth line of a .CVD file is the value of the BETA coefficient. If
your probe does not have a BETA coefficient, this value should be set to
0.0.

9972 INFO-CON 23

3 Edit Menu

Figure 12 .CVD File Format



3.2.6.2 I90 Files

The following is an example of the format of the .I90 file.

• The first line of a .I90 file is the value of the RTPW (Resistance at the
Triple Point of Water) coefficient.

• The second line of a .I90 file indicates which High Range is used. For
this software, this value should always be set to 6 regardless of the actual
range.

• The third line of a .I90 file is the value of the High Range A coefficient
(i.e. A6, A7, A8, A9, A10 or A11).

• The fourth line of a .I90 file is the value of the High Range B coefficient
(i.e. B6, B7, B8 or  B9). If using range 10 or 11, set this value to 0.0.

• The fifth line of a .I90 file is the value of the High Range C coefficient
(i.e. C6 or C7). If using range 8, 9, 10 or 11, set this value to 0.0.

• The sixth line of a .I90 file is the value of the High Range D coefficient.
If not using range 6, set this value to 0.0.

• The seventh line of a .I90 file indicates which Low Range is used. For
this software, this value should always be set to 4 regardless of the actual
range.

Note: Ranges 1, 2, and 3 are not supported by the 1521 LLK or 1522
LLL Handheld Thermometer readouts.

• The eighth line of a .I90 file is the value of the Low Range A coefficient
(i.e. A4 or A5).

• The ninth line of a .I90 file is the value of the Low Range B coefficient
(i.e. B4 or B5).
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3.2.6.3 THR Files

The following is an example of the format of the .THR file.

• The first line of a .THR file must always be set to 0 to indicate a thermis-
tor polynomial.

• The second line of a .THR file is the value of the T(R) coefficient b0
(sometimes called "a").

• The third line of a .THR file is the value of the T(R) coefficient b1 (some-
times called "b").

• The fourth line of a .THR file is the value of the T(R) coefficient b2
(sometimes called "c").

• The fifth line of a .THR file is the value of the T(R) coefficient b3 (some-
times called "d").
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4 Connector Menu

The Connector menu (Figure 15) provides options for formatting, reading, and
writing INFO-CON connector settings

4.1 Format
The Format option erases the settings in the INFO-CON connector so that the
settings for a new probe can be entered. The software always prompts for con-
firmation before erasing the current settings.

Once a connector has been erased, it no longer contains any information about
a probe.

This feature is useful when a probe must be disconnected from an INFO-CON
connector so that a new probe can be connected to it. Erasing the current set-
tings ensures that the INFO-CON connector will not contain any incorrect in-
formation about the connected probe.

Selecting Format from the Connector menu performs the same function as se-
lecting New from the File menu.

4.2 Read Settings
The Read Settings menu option forces the software to read in the current set-
tings from the INFO-CON connector. This feature is useful for discarding any
changes that have been made to the settings but have not yet been written out to
the INFO-CON connector.

4.3 Write Settings
The Write Settings menu option writes any changes that have been made to the
INFO-CON connector information since the last time the information was read.

By default, any time changes are made to the INFO-CON connector informa-
tion, the software prompts the user to choose whether to write the changes to
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the connector or not. If the changes are not written to the connector at this time,
the Write Settings menu option and toolbar button are enabled. These changes
must then be written to the connector manually by selecting the Write Settings
menu option or by selecting the Write Settings toolbar button.

Note: If the INFO-CON connector is detached from the Model 2372
INFO-CON Download Adapter before changes have been written to the con-
nector, a warning message is displayed. All changes that have been made will
be lost unless the INFO-CON connector is reconnected and the changes are
written to the connector.
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5 Help Menu

The Help menu (Figure 16) provides options for displaying the Help file, tech-
nical support information, and general software information including the soft-
ware version.

5.1 Contents
The Contents menu option displays the Contents topic of the Help file.

5.2 Index
The Index menu option displays the Index dialog for the Help file.

5.3 Technical Support
The Technical Support menu option displays Technical Support information.

Technical support can be obtained by calling or faxing Hart Scientific Technical
Support:

• Phone: (801) 763-1600

• Toll Free: 1-800-GET-HART (1-800-438-4278)

• Fax: (801) 763-1010

• E-mail: support@hartscientific.com

• Internet: www.hartscientific.com (Check our website on the Internet regu-
larly for answers to Frequently Asked Questions, updates, and Service
Releases.)

Before calling for Technical Support, check the topics listed below to see if the
problem you are having is described there.
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• Requirements (see Section 1.3)

• Software Installation (see Section 1.4)

• Running the Software (see Section 1.6)

• Required .DLL and .OCX Files  (see Section 1.7)

When calling or sending a fax, please send or have the following information
ready:

• Name of the software

• Software version (as found on the Help|About dialog)

• Detailed description of the problem

• What you were doing when the problem arose

• The exact wording of any error message you received

• Any other information that may help to solve the problem
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5.4 About
The About dialog displays specific information about the software. This infor-
mation includes:

• Software Icon

• Software Model Number

• Software Name

• Software Version

• Software Information.
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6 Glossary

ALPHA
The value of the ALPHA coefficient for the Callendar-Van Dusen or
IEC-751 conversion type.

BETA
The value of the BETA coefficient for the Callendar-Van Dusen or IEC-751
conversion type.

b0
The value of the b0 coefficient for the Thermistor conversion type.

b1
The value of the b1 coefficient for the Thermistor conversion type.

b2
The value of the b2 coefficient for the Thermistor conversion type.

b3
The value of the b3 coefficient for the Thermistor conversion type.

Calibration Date
The date that the probe attached to the INFO-CON connector was last
calibrated.

Coefficients
The values that represent the characterization of a probe. Every probe has its
own unique set of coefficients.

COM Port
An RS-232 connector on a computer to which the Model 2372 INFO-CON
Download Adapter muse be connected.

Conversion Type
Determines what type of coefficients can be entered for a probe.

DELTA
The value of the DELTA coefficient for the Callendar-Van Dusen or IEC-751
conversion type.

Expiration Date
The date that the calibration of the probe attached to the INFO-CON connec-
tor expires.

High Range
This refers to the High Range for the ITS-90 conversion type. The ITS-90
conversion type consists of high ranges 6, 7, 8, 9, 10, and 11.
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High Range A Coefficient
The value of the High Range A coefficient (i.e. A6, A7, ... or A11) for the
ITS-90 conversion type.

High Range B Coefficient
The value of the High Range B coefficient (i.e. B5, B6, B7, ... or B9) for the
ITS-90 conversion type.

High Range C Coefficient
The value of the High Range C coefficient (i.e. C6 or C7) for the ITS-90
conversion type.

High Range D Coefficient
The value of the High Range D coefficient for the ITS-90 conversion type.

ICF Files
Binary files which contain the information exactly as it is stored in an
INFO-CON connector. These files are very compact (typically only 100
bytes in size). Because these files are binary (as opposed to text), they can-
not be read by a text editor.

Incompatible Files
A list of files that are required by the software that either could not be found
on the system or have been changed.

Incompatible File Details
Details of the conflicts found with the file selected from the Incompatible
Files list.

Low Range
This refers to the Low Range for the ITS-90 conversion type. The ITS-90
conversion type consists of high ranges 1, 2, 3, 4, and 5. Only ranges 4 and 5
are supported by the software.

Low Range A Coefficient
The value of the Low Range A coefficient (i.e. A4 or A5) for the ITS-90
conversion type.

Low Range B Coefficient
The value of the Low Range B coefficient (i.e. B4 or B5) for the ITS-90 con-
version type.

Menu Bar
Provides access to all of the features of the software.

R0
The value of the R0 coefficient for the Callendar-Van Dusen or IEC-751
conversion type.

RTPW
The value of the Resistance at the Triple Point of Water for the ITS-90 con-
version type.
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Select Wires
Specifies how the probe is attached to the INFO-CON connector.

Status Bar
Displays information concerning the operation that the software is currently
performing.

Toolbar
Provides quick access to the most common functions of the software.
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